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Thank you very much for selecting the Bluetooth Utility.
This Help facility will show you how to use the Bluetooth Utility for configuring Bluetooth devices 
and how it can be used in other convenient ways. 
We hope that the Help facility will enable you to be able to make full use of the Bluetooth Utility.

What is Bluetooth? 
What you need to know about using Bluetooth 
Varieties of Bluetooth devices you can use 
Contents of the Bluetooth Utility 

[Trademark information]

(C) 2003, 2004 TOSHIBA Corporation All Rights Reserved

Bluetooth is a global standard telecommunications method that enables data to be exchanged 
wirelessly between personal computers, peripheral components, mobile telephones and other 
electronic devices.
Data can be readily exchanged between Bluetooth devices if they have been registered as 
components able to communicate with each other. 

A maximum of seven Bluetooth devices may be connected together. By using Bluetooth to connect 
to a mouse, keyboard, modem, printer, or other device, you can do away with messy cabling and 
not have to be concerned about space restrictions, which will allow you to work more comfortably. 

Next

Introduction

What is Bluetooth?



Introduction 第 2 頁，共 224 頁

file://C:\Documents and Settings\anitachou\Local Settings\Temp\~hh114B.htm 2004/11/30

Next

Bluetooth exchanges data using radio waves.
The following points are critical in order to configure and use Bluetooth devices correctly. 

The devices must be Bluetooth-compatible 
The Bluetooth devices must be close enough to be able to communicate 
The devices must be in a connectable state 
No other radio wave-emitting devices should be operated nearby 
The Bluetooth devices must be turned on

The hardware and software used in your PC and other components must be Bluetooth-
compatible.
Bluetooth-compatible products normally bear the following logo:

For further details, please refer to your local retailer or consult the product instruction manual. 

A Bluetooth communication card, adapter, or other similar device (not included) needs to 
be installed in PCs or PDAs (personal digital assistants) that do not have Bluetooth built 
in. 

Bluetooth devices situated in places beyond the reach of the radio waves will not recognize 
each other, making communication impossible.
In particular, please ensure that your Bluetooth devices can communicate with each other before
you register and configure them for the first time. 

PCs have a communication distance restriction of ten meters. Please refer to the 
instruction manuals for information on the communication distance restrictions specific to 
each device. 
Communication interference may occur if any obstructions are located between the 
devices. Devices may not communicate properly if they have been located, for example, 
on the ground and first floors of a residence, despite their being within the acceptable 
distance. 

The devices must be Bluetooth-compatible

Note

The Bluetooth devices must be close enough to be able to communicate

Note

What you need to know about using Bluetooth



NOTE: THE MANUFACTURER IS NOT RESPONSIBLE FOR ANY RADIO OR TV 
INTERERENCE CAUSED BY UNAUTHORIZED MODIEICATIONS TO THIS 
EQUIP-MENT.SUCH MODIFICATIONS COULD VOID THE USER AUTHORITY TO 
OPERATE THE EQUIPMENT. 



Introduction 第 3 頁，共 224 頁

file://C:\Documents and Settings\anitachou\Local Settings\Temp\~hh114B.htm 2004/11/30

The Bluetooth devices must recognize each other in order to be connectable for use.
In certain devices, simply turning on the power will not produce a connectable state. Moreover, 
the energy-saving feature may come into effect after a certain amount of time, which will 
prevent the devices from being detected. Please refer to the specific product instruction manual 
for further details. 

Microwave ovens, wireless LANs and other radio wave-emitting devices located nearby may 
affect Bluetooth communication.
Please ensure that your devices have been accordingly situated, and that the above devices are 
not in use when you are operating your Bluetooth device.

Bluetooth cannot be used if the devices have not been turned on.
Some PCs and other components have a Bluetooth communication switch that operates 
independently of the main power. Bluetooth cannot function if this switch has been turned off. 

Using PCs with Bluetooth built in  
When using a Bluetooth USB adapter or SD card 

The devices must be in a connectable state

No other radio wave-emitting devices should be operated nearby

The Bluetooth devices must be turned on

It is important to understand the concepts of "services" and "profiles" in order to determine whether 
an intended function can be properly utilized when you use a Bluetooth device. 

Examples of Bluetooth devices include mice and keyboards (input devices), printers (output 
devices) and wireless modems (communication devices). Functions that can be utilized by such 
devices are called "services." 

In order for these services to be used reliably, Bluetooth devices are provided with common 
specifications known as "profiles."
For example, when a PC makes a connection to a Bluetooth device, it obtains the profile of the 
corresponding device and thereby ascertains which functions (services) the device offers. 

As an example, imagine someone who travels overseas. 

The traveller is only able to converse properly with their counterpart if both speak a language 
(English, Japanese, Chinese, etc.) they both understand.

What is a "profile"?

Varieties of Bluetooth devices you can use
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However, no dialogue will occur if they do not share a common language.

 

In the above example, the traveller and his/her counterpart correspond to the devices, the 
languages to the profiles, and the dialogues between the two people to the services. The former 
example refers to a situation where a service can be performed because the devices support a 
common profile, whereas the latter example refers to a situation where a service cannot be 
performed because a common profile is not supported. 

In other words, you will be able to use Bluetooth devices that have a profile supported by a PC 
(the Bluetooth Utility in this case).
If the profiles belonging to the device are not supported by the PC, the functions corresponding 
to those profiles will not be able to be utilized. Also, a device can only be used if its profiles are 
supported by the PC. 

The following profiles are supported by the Bluetooth Utility: 

Types of profiles

Term Definition

DUN
Dial-Up Networking
Enables you to establish a dial-up Bluetooth connection to the Internet or other 
networks with a wireless modem station, mobile telephone, or similar device.

FAX
FAX
Enables you to establish a Bluetooth connection with a wireless modem station, 
mobile telephone, or similar device to send or receive a fax. 

LAP
LAN Access Profile
Enables you to establish a Bluetooth connection with a LAN access point to 
access the services of a LAN using PPP.

SPP

Serial Port Profile
Enables communication with a device through a virtual serial port configured for 
a Bluetooth connection. This can be used for printers and printer adapters with 
PDAs, using a different method from HCRP or ActiveSync.

HID
Human Interface Device Profile
All ti t i l i k b d d th i td i
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Allows connections to wireless mice, keyboards and other input devices.

HCRP
Hardcopy Cable Replacement Profile
Enables printing with a printer driver.

FTP
File Transfer Profile
Enables you to browse folders on a wireless device and transfer files to and from 
the local device.

OPP
Object Push Profile
Allows business card data to be exchanged with a wireless device.

A2DP
Advanced Audio Distribution Profile
Allows audio data to be exchanged between wireless headsets and other audio 
devices, as well as allowing high-quality music playback.

AVRCP
Audio/Video Remote Control Profile
A/V remote control functions such as play and stop. The Bluetooth Utility 
supports remote control operation.

GAVDP
Generic Audio/Video Distribution Profile
Basic profile used to support A2DP, AVRCP and other protocols.

HSP

Head Set Profile
Profile used for headsets.
Allows you to connect to a PC and communicate as well as connect to a mobile 
telephone.

PAN
Personal Area Networking Profile
Supports IP base network. Allows connection to an ad-hoc or wired network via 
an access point.

BIP

Basic Imaging Profile
Allows image files to be sent and received after having been converted to a size 
suitable for the destination. In addition to being able to transfer image files, the 
Bluetooth Utility allows camera shutters to be operated by remote control, as well 
as other offering other functionalities.

The Bluetooth Utility is a software tool used to configure a variety of settings once a connection 
has been established between the PC and the Bluetooth device. It also facilitates the exchange of 
files between Bluetooth devices.

The Bluetooth Utility comprises the following six tools. Descriptions are provided for the functions 
and the supported profiles for the respective tools. 

Bluetooth Settings 
Bluetooth Manager 
Bluetooth Information Exchanger 
Remote Camera 
Bluetooth Local COM 
Wireless File Transfer 

Bluetooth Settings

Contents of the Bluetooth Utility 
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This program enables you to easily configure settings when you connect to a Bluetooth device 
for the first time. The function of a configured and registered device is displayed on the main 
window as a connection icon.
As a rule, the Bluetooth device will be connected automatically after having been set up; 
however, a shortcut can be created for a manual connection, if so required. 

This program, which appears as a Taskbar icon, monitors and controls the power and operating 
status of Bluetooth devices. It can be used to start the Bluetooth Setup Utility, add a new 
connection, disconnect from a remote device, and perform other tasks.

This program enables you to easily transfer files and images to or exchange business card data 
with a wireless device by selecting the icon of the counterpart device, or using the right-click 
menu in Explorer. The wireless devices to which you are connecting must also support the same
service functions (FTP and OPP). 

Bluetooth Manager

Bluetooth Information Exchanger
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Related topics
→"Exchanging files with PCs and PDAs"
→"Sending images to mobile telephones"
→"Sending images to PCs or PDAs"
→"Exchanging business card data with PCs and PDAs"

Connecting to a Bluetooth-compatible digital camera allows the device to be operated from the 
PC side, and captured images to be sent to the PC.

Related topics
→"Using a Bluetooth-compatible camera"

This program, which is registered in the Control Panel, can create a virtual COM port for use 
with the Bluetooth Utility. If you need to create a client COM port with the Bluetooth Setup 
Utility, it can be created automatically without having to start the program.

Remote Camera

Bluetooth Local COM
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↓

Related topics
→"Manually creating a virtual Bluetooth COM port" 

You can send a file wirelessly to another device by right-clicking on the intended file and using 
the "Sending to Bluetooth Device" menu that appears.

Wireless File Transfer



Introduction 第 9 頁，共 224 頁

file://C:\Documents and Settings\anitachou\Local Settings\Temp\~hh114B.htm 2004/11/30

Related topics
→"Exchanging files with PCs and PDAs"

 

　 

Actual examples of how to establish a connection to a Bluetooth device using the Bluetooth Utility 
are described in this section.

Descriptions of more convenient methods and detailed information on the Bluetooth Utility 
functions are also provided.

Flow of operation 
Basic settings 
Making the most of your Bluetooth device 
Using the features more effectively 
Bluetooth Utility functions in detail

The Bluetooth Utility operates under Windows XP and Windows 2000.
The descriptions in the examples mainly pertain to operation under Windows XP.

Windows XP: Microsoft® Windows® XP Operating System
Windows 2000: Microsoft® Windows® 2000 Operating System 

 

Next

Note

Using the Bluetooth Utility

Flowofoperation
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The procedure below is used to set up Bluetooth devices using the Bluetooth Utility. 

It is assumed that the set-up is performed from the [Bluetooth Settings] window. 

     

 

Next

Note

: Enter Bluetooth passkey (PIN code), if required by the device.

: During these stages of the set-up process, the Bluetooth device must 
be set to Connectability mode.

* Simply turning the power on will activate Connectability mode in 
certain devices. Please refer to the device instruction manual for 
further details.

Flow of operation
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Methods for registering new devices using the Bluetooth Utility shall now be described.
A Bluetooth mouse shall be connected and set up using [Bluetooth Settings] as an example.

[Bluetooth Settings] provides two set-up methods: "Express Mode" and "Custom Mode."

Express Mode
[Bluetooth Settings] will automatically detect and register services. If several services 
(profiles) are supported by the device, the service that has been set to the highest priority shall 
be selected and registered.
Express Mode is normally recommended for device set-up.

Custom Mode
After having been detected, the services supported by the device are displayed as a list, from 
which you can select the desired function(s).
Custom Mode must be used to set up a device if, for example, you wish to use a modem 
station to send a fax (because in Express Mode, the DUN profile will be automatically 
selected since it has a higher priority than the FAX profile). 

The differences between setting up the same device (a Bluetooth mouse) using Express Mode and 
Custom Mode are described on the following pages.

Express Mode Set-up 
Custom Mode Set-up

The procedure for setting up the device using Express Mode shall now be described. 

  

1. Click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings].
(Under Windows 2000, click [Start]→[Programs]→[Bluetooth]→[Bluetooth Settings].) 

The same result can be achieved by right-clicking on the Bluetooth icon in the 
task tray and selecting [Bluetooth Settings] from the menu that appears.

Starting Bluetooth Settings

Procedure

Note

Basic settings

Express Mode Set-up
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The [Bluetooth Settings] window below will appear when other devices have already 
been registered.

Please click the [New Connection] button to open the [Add New Connection Wizard] 
window. If no devices have been registered yet, please proceed directly to "Detecting 
Bluetooth Devices." 

(continued in "Detecting Bluetooth Devices"...) 

　Next

　 

(...continued from previous step)

Detecting Bluetooth devices

Procedure
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( p p)
The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] window 
will appear.

1. Switch the mouse power ON to make it connectable via Bluetooth.
Please refer to the mouse instruction manual for details on this procedure.

2. Confirm that [Express Mode] has been selected in the [Add New Connection Wizard 
(Welcome to the Add New Connection Wizard)] window, and click on the [Next] 
button.

Searching for Bluetooth devices will start.

When the mouse has been detected, the name and address of the device will appear in 
the [Add New Connection Wizard (Select Device)] window.
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If no device is found, please confirm that the device has been made connectable 
via Bluetooth, and click on the [Update] button.
A further device search will be performed. 

(→ continued in [Detecting Services]...) 

Next

Note

 

(...continued from previous step)
When the mouse has been detected, the name and address of the device will appear in the [Add 
New Connection Wizard (Select Device)] window.

1. Select the mouse device name from [Device List] and click on the [Next] button.

Detecting services

Procedure
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Bluetooth device detection will commence.

 

If several services (profiles) are supported by the device, the service that has been 
set to the highest priority shall be automatically selected and set up in Express 
Mode.
Please use Custom Mode if you wish to select desired services manually. 
When a service has been detected, a window prompting you to enter the Bluetooth 
passkey (PIN code) may appear. Please enter the passkey and click on the [OK] 
button.
Please refer to your device instruction manual for information on which passkey 
to use.

If you have not entered your Bluetooth passkey after a certain amount of time has 

Note
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passed, the connection process will be cancelled for security reasons. Please 
perform the passkey entry process again.

A message will appear prompting you to prepare the device for connection.

2. Click on the [OK] button

 

When the settings information has been registered, a window prompting you to 
enter your Bluetooth passkey (PIN code) may appear. Please enter your passkey 
and click on the [OK] button.
Please refer to your device instruction manual for information on which passkey 
to use.

If you have not entered your Bluetooth passkey after a certain amount of time has 
passed, the connection process will be cancelled for security reasons. Please 
perform the passkey entry process again. 

The [Add New Connection Wizard (Connection Name Setup)] window will appear if a 
service has been properly detected. 

3. Select the type and name of the icon to be displayed once the device has been 
registered, and click on the [Next] button.

Note
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If you wish to change the icon, please click on the [Change Icon] button and 
select your preferred icon from the list that appears.

 

(→ continued in [Registering Settings Information]...) 

Note

Next

　 

(...continued from previous step)
The [Add New Connection Wizard (Completing the Add New Connection Wizard)] window 
will appear. 

1. Click on the [Finish] button

Registering settings information

Procedure
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The [Bluetooth Settings] window will appear.
The icons of the registered devices will appear, and the devices will be ready to use.

The connection icons and icon names can be changed.

Changing a connection icon name 

Changing a connection icon 

　 

Note

CustomModeSetup
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The procedure for setting up the device using Custom Mode shall now be described. 

  

1. Click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings].
(Under Windows 2000, click [Start]→[Programs]→[Bluetooth]→[Bluetooth 
Settings].） 

The same result can be achieved by right-clicking on the Bluetooth icon in the 
task tray and selecting [Bluetooth Settings] from the menu that appears.

 

The [Bluetooth Settings] window below will appear when other devices have already 
been registered.

Please click the [New Connection] button to open the [Add New Connection Wizard] 
window Ifnodeviceshavebeenregisteredyet pleaseproceeddirectlyto"Detecting

Starting Bluetooth Settings

Procedure

Note

Custom Mode Set-up
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window. If no devices have been registered yet, please proceed directly to Detecting 
Bluetooth Devices". 

(continued in "Detecting Bluetooth Devices"...) 

　Next

　 

(...continued from previous step)
The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] window 
will appear. 

1. Switch the mouse power ON to make it connectable via Bluetooth.
Please refer to the mouse instruction manual for details on this procedure.

2. Confirm that [Custom Mode] has been selected in the [Add New Connection Wizard 
(Welcome to the Add New Connection Wizard)] window, and click on the [Next] 
button.

Searching for Bluetooth devices will start.

Detecting Bluetooth devices

Procedure
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When the mouse has been detected, the name and address of the device will appear in 
the [Add New Connection Wizard (Select Device)] window.

 

If no device is found, please confirm that the device has been made connectable 
via Bluetooth, and click on the [Update] button.
A further device search will be performed. 

(→ continued in [Detecting Services]...) 

 

　　Next

　 

Note
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(...continued from previous step)
When the mouse has been detected, the name and address of the device will appear in the [Add 
New Connection Wizard (Select Device)] window.

1. Select the mouse device name from [Device List] and click on the [Next] button

Bluetooth device detection will commence.

Detecting services

Procedure
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When a service has been detected, a window prompting you to enter the Bluetooth
passkey (PIN code) may appear. Please enter the passkey and click on the [OK] 
button.
Please refer to your device instruction manual for information on which passkey 
to use.
 

If you have not entered your Bluetooth passkey after a certain amount of time has 
passed, the connection process will be cancelled for security reasons. Please 
perform the passkey entry process again.

If you try to register a device that has already been registered, the following 
message will appear, and you will not be able to proceed with further operation.
Please click on the [OK] button to close the message.

 

The services supported by the device will be displayed.

2. Select the desired service and click on the [Next] button

Note
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When a device supports several services
If the device supports several services, you can use Custom Mode to manually 
select the services (profiles) you wish to use from the list that appears under 
[Select Services].

Example: List of wireless modem station services
　　

　　

If Express Mode is used to perform the set-up, the highest-priority service in the 
device will be automatically selected and configured. 　 

3. Click on the [OK] button.

 

When the settings information has been registered, a window prompting you to 
enter the Bluetooth passkey (PIN code) may appear. Please enter the passkey and 
click on the [OK] button.
Please refer to your device instruction manual for information on which passkey 
to use.　

If you have not entered your Bluetooth passkey after a certain amount of time has 
passed, the connection process will be cancelled for security reasons. Please 
perform the passkey entry process again. 

The [Add New Connection Wizard (Connection Name Setup)] window will appear if a 
service has been properly detected.

Note

Note
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4. Select the type and name of the icon to be displayed once the device has been 
registered, and click on the [Next] button.

 

If you wish to change the icon, please click on the [Change Icon] button and 
select your preferred icon from the list that appears.

 

(→ continued in [Registering Settings Information]...)

Next

Note
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(...continued from previous step)
The [Add New Connection Wizard (Completing the Add New Connection Wizard)] window 
will appear. 

1. Click on the [Finish] button

The [Bluetooth Settings] window will appear.
The icons of the registered devices will appear, and the devices will be ready to use.

Registering settings information

Procedure
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The connection icons and icon names can be changed.

Changing a connection icon name

Changing a connection icon 

Note

You can use a Bluetooth wireless modem to connect to the Internet via a telephone line. 

→Setting up the modem station
→Connecting to the Internet 

In order to connect to the Internet, you must have already signed up with a provider and 
obtained a connection ID and password. Please ensure you have confirmed the ID, password 
and telephone number of your provider's access point before you begin the set-up process. 
Please refer to your instruction manual for information on connecting the modem station to a 
telephone line. 
A Bluetooth passkey (PIN code) is required for you to connect to the modem station. Please 
make a note of your Bluetooth passkey before you start the set-up process. 

1. Turn on the wireless modem station

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New 
Connection]

Important

Setting up the modem station

Procedure

Connecting to the Internet using a modem station [DUN]
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Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], 
and then click on [New Connection] from the active [Bluetooth Settings] window. 

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] 
window will appear. 

3. Confirm that [Express Mode] has been selected, and then click on the [Next] button

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will 
appear.

Note
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4. Select the device name of the wireless modem station from [Device List], and then 
click on the [Next] button

The [Add New Connection Wizard (Searching for Services)] window will appear.

Once a service has been detected successfully, connection to the device and COM port 
creation will be performed automatically, after which the [Add New Connection Wizard 
(Modem Settings)] window will appear.

5. If you are connecting to a wireless modem station for the first time, enter the passkey 
for the modem station under [Bluetooth Passkey (PIN code)], and then click on the 
[OK] button
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Once the program has finished searching for the devices, the [Add New Connection 
Wizard (Device Selection)] window will appear.

6. Click on the [Next] button

Certain modems require you to configure initialization commands separately.
Please click on the [Additional initialization Command Settings] button, enter the 
initialization commands in the following window, and then click on the [OK] button.

 

Please refer to the modem or mobile phone instruction manual for further details 
on the initialization commands. 

Note
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7. Enter the connection name (optional), telephone number (of your provider's access 
point), user name and password (as issued by your provider), and then click on the 
[Finish] button.

 

The sample entries shown in the window are provided solely for purpose of 
explanation. Please use your own telephone number, ID and password according 
to the arrangement with your provider. 

The settings will be registered, and an icon will appear in the [Bluetooth Settings] 
window.

You can connect to the Internet by following the procedure below if the connection destination 
registered when you configured the wireless modem has been set as the default connection 
destination. 

1. Start your browser, e-mail application or other application 

Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application). 

2. Enter the URL of the Web page you wish to display and then press the [Enter] key, or 
use the e-mail tool to send/receive items or perform other activities. 

The [Dial-up Connection] window will appear.

3. Click on the [Connect] button

Important

Connecting to the Internet

Important
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A connection will be automatically established with the modem station if COM 
Auto Connect is available. If COM Auto Connect is not available, please 
manually connect to the modem station. 

The following message will appear once you have connected to the Internet.

4. End the connection 

The window below will appear if you double-click on the icon in the task bar.

 

Please click on the [Disconnect] button when you want to disconnect from the Internet.

Alternatively, please right-click on the icon, and then click on [Disconnect].

Important
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You can start an application to make an automatic connection to the Internet, but you can 
also make a manual connection using the connection destination icon.
The procedure is described below. 

1. From the [Bluetooth Settings] window, right-click on the connection destination icon, 
and then click on [Connect] from the menu that appears

A window indicating that the connection is being established will appear.

If the connection has been established successfully, the connection icon and task tray 
will appear as shown below. 

Note
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You will be able to browse Web pages using your browser and send and receive e-
mail.  

Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application). 

2. End the connection
Right-click on the icon, and then click [Disconnect] to end the connection. 

The following message will appear. Click on the [Yes] button.

When the icon appears as shown below, the connection will have ended.

 

Important

ConnectingtotheInternetusingamobiletelephone[DUN]
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This section describes how to connect to the Internet via a telephone line, using a mobile 
telephone.  

→Configuring a mobile telephone for use as a modem
→Connecting to the Internet 

In order to connect to the Internet, you must have already signed up with a provider and 
obtained a connection ID and password. Please ensure you have confirmed the ID, 
password and telephone number of your provider's access point before you begin the set-
up process. 

A Bluetooth passkey (PIN code) is required for you to connect to the mobile telephone. 
Please make a note of your Bluetooth passkey before you start the set-up process. 

1. Turn on the mobile telephone, and set it to be connectable via Bluetooth

Please refer to the mobile telephone instruction manual for information on how to 
operate the device. 

2. Right-click on the Bluetooth icon in the task tray, and then click on [Add New 
Connection]

Important

Configuring a mobile telephone for use as a modem

Procedure

Note

Connecting to the Internet using a mobile telephone[DUN]
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Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], 
and then click on [New Connection] from the active [Bluetooth Settings] window. 

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] 
window will appear.

3. Confirm that [Express Mode] has been selected, and then click on the [Next] button

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will 
appear.

4. Select the device name of the mobile telephone from [Device List], and then click on 
the [Next] button

Note
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The [Add New Connection Wizard (Searching for Services)] window will appear.

Once a service has been detected successfully, connection to the device and COM port 
creation will be performed automatically, after which the [Add New Connection Wizard 
(Modem Settings)] window will appear. 

5. If you are connecting to a mobile telephone for the first time, enter the passkey for the 
wireless modem station under [Bluetooth Passkey (PIN code)], and then click on the 
[OK] button
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Once the program has finished searching for the devices, the [Add New Connection 
Wizard (Device Selection)] window will appear.

6. Click on the [Next] button

Certain modems require you to configure initialization commands separately.
Please click on the [Additional Initialization Command Settings] button, enter the 
initialization commands in the following window, and then click on the [OK] button.

 

Please refer to the modem or mobile phone instruction manual for further details 
on the initialization commands. 

7. Enter the connection name (optional), telephone number (of your provider's access 
point), user name and password (as issued by your provider), and then click on the 
[Finish] button.

Note
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The sample entries shown in the window are provided solely for purpose of 
explanation. Please use your own telephone number, ID and password according 
to the arrangement with your provider. 

The settings will be registered, and an icon will appear in the [Bluetooth Settings] 
window.

You can connect to the Internet by following the procedure below if the connection destination 
registered when you configured the mobile telephone has been set as the default connection 
destination. 

1. Start your browser, e-mail application or other application 

Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application). 

2. Enter the URL of the Web page you wish to display and then press the [Enter] key, or 
use the e-mail tool to send/receive items or perform other activities.

The [Dial-up Connection] window will appear.

3. Click on the [Connect] button

Important

Connecting to the Internet

Important
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A connection will be automatically established with the mobile telephone if COM 
Auto Connect is available. If COM Auto Connect is not available, please 
manually connect to the mobile telephone. 

The following message will appear once you have connected to the Internet.

4. End the connection 

The window below will appear if you double-click on the icon in the task bar.

 

Please click on the [Disconnect] button when you want to disconnect from the Internet.

Alternatively, please right-click on the icon, and then click on [Disconnect].

Important
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You can start an application to make an automatic connection to the Internet, but you can 
also make a manual connection using the connection destination icon.
The procedure is described below. 

1. From the [Bluetooth Settings] window, right-click on the connection destination icon, 
and then click on [Connect] from the menu that appears

A window indicating that the connection is being established will appear.

If the connection has been established successfully, the connection icon and task tray 
will appear as shown below.

      

You will be able to browse Web pages using your browser and send and receive e-mail. 

Note
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Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application). 

2. End the connection
Right-click on the icon, and then click [Disconnect] to end a connection.

The following message will appear. Click on the [Yes] button.

When the icon appears as shown below, the connection will have been ended.

 

Important

This section describes how to connect to a network (for example, a company LAN or a personal 
home network) using a LAP profile-compatible access point.
Please refer to "Using an access point (PAN) to connect to a LAN if you are using a PAN profile-
compatible access point.

Connecting to a LAN using an access point (LAP) [LAP]
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→Setting up the access point
→Connecting to a LAN (LAP) 

The access point must have been started and a normal connection already established to 
the network before the access point is set up. Please refer to the access point instruction 
manual for information on how to set up the access point.
A Bluetooth passkey (PIN code) is required for you to connect to the access point. Please 
make a note of your Bluetooth passkey before you start the set-up process. 

1. Turn on the access point, and confirm that a connection has been established with the 
network 

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New 
Connection]

 

Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], 
and then click on [New Connection] from the active [Bluetooth Settings] window. 

The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] window will appear. 

3. Confirm that [Express Mode] has been selected, and then click on the [Next] button

Important

Setting up the access point

Procedure

Note
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The [Add New Connection Wizard (Searching for Bluetooth devices)] window 
will appear.

Once the program has finished searching for the devices, the [Add New 
Connection Wizard (Device Selection)] window will appear.  

4. Select the device name of the access point from [Device List], and then click on the 
[Next] button
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The [Add New Connection Wizard (Searching for Services)] window will appear.

 

You will be asked for the Bluetooth passkey in the window that appears.

5. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on the [OK] 
button

Service detection and COM port creation will be performed automatically.
The [Add New Connection Wizard (Create Connection Destination)] window will 
appear.

6. Enter the connection name, user name and password, then click on the [Next] button
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The user name and password are entered here to allow you to connect to the 
access point. 

The [Add New Connection Wizard (Confirm Dial-up Settings)] window will appear. 

7. Click on the [Confirm Settings] button

The [Internet Options] window will appear.

8. Configure the connection method, and then click on the [OK] button
Set the connection destination used for the LAN connection set up in (6) above as the 
default connection destination, and then select "Always dial my default connection." 

Note
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9. Click on the [Next] button

The [Add New Connection Wizard (Connection Name Settings)] window will appear. 

10. Enter the type and name of the icon displayed after registration, and then click on the 
[Next] button
Please click on the [Next] button if you are satisfied with the settings. 
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The [Add New Connection Wizard (Completing the Add New Connection Wizard)] 
window will appear.

11. Click on the [Finish] button

The access point icon will be registered in the [Bluetooth Settings] window.

 

 

This will complete the access point set-up process.

→"Connecting to a LAN (LAP)" 

 

1. Right-click on the connection icon in the [Bluetooth Settings] window, and then click 
on [Connect]

The[Dial-upConnection]windowwillappear

Procedure

Connecting to a LAN (LAP)



Introduction 第 49 頁，共 224 頁

file://C:\Documents and Settings\anitachou\Local Settings\Temp\~hh114B.htm 2004/11/30

The [Dial-up Connection] window will appear.

2. Confirm that "Direct connection" has been selected under [Connection Destination], 
and then click on the [Connect] button 

A connection will be initiated. 

This is an example of what happens when you use "Direct connection" as a 
connection name under "Connect to access point." If a name different from the 
connection name is used, that name will appear under [Connection Destination]. 
Please simply click on [Settings] if no user name or password have been entered 
(i.e., if those fields have been left blank)
Please change the connection destination if a different connection name (for a 
dial-up connection) appears in [Connection Destination].

Related topic→"Changing the default connection destination" 

Once you connect to the network, Internet Explorer will start automatically, and you 
will be able to exchange data with other computers on the network.

Please follow the procedure below if you need to set up a proxy server to connect 
to the Internet (the following procedure is not necessary if the PC you are going to 
use has already been set up as a proxy server).

1 Select [Internet Options...] from the [Tools] menu in Internet Explorer

　The [Internet Options] window will appear.

2 Click on the [Connections] tab, and then click on the [Settings...] button

Note

Note
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3 Enter the IP address and port number of the proxy server under [Proxy Server], 
and then click on the [OK] button

　  

3. End the connection 
Right-click either on the connection icon under the [Bluetooth Settings] window or on 

the icon in the task tray, and then click on [Disconnect].

Click on the "Yes" button in the disconnection confirmation dialog box that appears. 
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This section describes how to connect to a network (for example, a company LAN or a personal 
home network) using a PAN profile-compatible access point.
Please refer to "Using an access point (LAP) to connect to a LAN" if you are using a LAP profile-
compatible access point.

→Setting up the access point
→Connecting to a LAN (PAN) 

The access point must be started and a normal connection already established to the 
network before the access point is set up. Please refer to the access point instruction 
manual for information on how to set up the access point. 
A Bluetooth passkey (PIN code) is required for you to connect to the access point. Please 
make a note of your Bluetooth passkey before you start the set-up process. 

1. Turn on the access point, and confirm that a connection has been established with the 
network

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New 
Connection]

Important

Setting up the access point

Procedure

Connecting to a LAN using an access point (PAN) [PAN]
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Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], 
and then click on [New Connection] from the active [Bluetooth Settings] window. 

The [Add New Connection Wizard (Welcome to the Add New Connection 
Wizard)] window will appear. 

3. Confirm that [Express Mode] has been selected, and then click on the [Next] button

 

The [Add New Connection Wizard (Searching for Bluetooth devices)] window 
will appear.

Once the program has finished searching for the devices, the [Add New 
Connection Wizard (Device Selection)] window will appear. 

4. Select the device name of the access point from [Device List], and then click on the 

Note
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[Next] button

The [Add New Connection Wizard (Searching for Services)] window will appear.

 

You will be asked for the Bluetooth passkey in the window that appears.

5. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on the [OK] 
button
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Service detection and COM port creation will be performed automatically.
The [Add New Connection Wizard (Connection Name Settings)] window will appear. 

6. Enter the type and name of the icon displayed after registration, and then click on the 
[Next] button
Please click on the [Next] button if you are satisfied with the settings.

The [Add New Connection Wizard (Completing the Add New Connection Wizard)] 
window will appear.

7. Click on the [Finish] button

The access point icon will be registered in the [Bluetooth Settings] window.

 

 

This will complete the access point set-up process.

→"Connecting to a LAN (PAN)" 

 

Connecting to a LAN (PAN)
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1. Right-click on the connection icon in the [Bluetooth Settings] window, and then click 
on [Connect]

You will be asked for the Bluetooth passkey in the window that appears.

2. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on the [OK] 
button

A connection will be initiated. 

Once you have connected to the network, Internet Explorer will start automatically, and 
you will be able to exchange data with other computers on the network.

Please follow the procedure below if you need to set up a proxy server to connect 
to the Internet (the following procedure is not necessary if the PC you are going to 
use has already been set up as a proxy server). 

1 Select [Internet Options...] from the [Tools] menu in Internet Explorer

　The [Internet Options] window will appear. 

2 Click on the [Connections] tab, and then click on the [LAN Settings...] button 

Procedure

Note
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3 Enter the IP address and port number of the proxy server under [Proxy Server], 
and then click on the [OK] button

　  

3. End the connection 
Right-click either on the connection icon under the [Bluetooth Settings] window or on 

the icon in the task tray, and then click on [Disconnect].

Click on the "Yes" button in the disconnection confirmation dialog box that appears. 
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You can use the PAN profile to build a network of Bluetooth -enabled devices.

 

→Operating as a server
→Operating as a client

A personal area network comprises a client-server architecture. The device to which other 
devices connect is called the "server", and a device that connects to the server is called a 
"client."
The client-server relationship is not necessarily a fixed one. The first of two devices to 
establish a connection can be the server when one other device is present, and can be the 
client in other instances.

The maximum total number of devices that can be used to constitute a single personal 
area network is seven: one server and six clients.
A network comprising as many as seven devices could theoretically be built, but an 
operating environment that involves the use of other Bluetooth devices, leaving aside 
other complications, might require the network to comprise fewer components..

By using the PAN profile, you will be able to build a network that uses the same TCP/IP 
protocol used in regular LANs. Accordingly, the machine designated as the server can be used 
for configuration tasks that utilize DHCP, such as assigning IP addresses to clients.

Note

Building a personal area network  [PAN]
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In addition, you will be able to configure folder and file sharing, which will allow data to be 
browsed by other servers or clients on the network.

　　　　

Please refer to Windows Help for further information on TCP/IP, DHCP and 
configurations for sharing. 

The following icon will appear in the tasktray when the PAN server function has been 
activated.

Should the icon not appear, please follow the procedure below to activate the PAN server 
function.

1. Right-click the Bluetooth icon in the task tray and make sure the Option [Use PAN 
Group Ad-hoc Network] is enabled. 
A message will appear asking you to confirm whether you wish to activate the PAN 
group ad-hoc network. 

2. Click the [Yes] button 

Important

Operating as a server
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[ ]
The PAN server will be activated, and an icon will accordingly appear in the tasktray. 
Other devices that use the PAN profile will now be able to connect over the network. 

When using the device as the server, make sure that all user accounts have a password 
set for the security reasons. 

By clicking on the icon, the [Bluetooth PAN Server] window will appear. 
In the graphic below, one client has established a connection.

 

When you try to connect to another server as a client, the task tray icon will disappear, 
and your machine will not be able to function as a server in response to connection 
requests originating from other devices.

Connecting to a server as a client is performed from the [Bluetooth Settings] window, as 
described below.

1. Right-click on the Bluetooth icon in the task tray, and click on [Add New Connection]

 

Important

Note

Operating as a client

Procedure

Note
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Alternatively, click on [Start]→[All Programs]→[Bluetooth]→[Bluetooth 
Settings], and then on [New Connection] from the [Bluetooth Settings] window. 

2. Confirm that [Express Mode] has been selected, and then click on the [Next] button

 

3. Click on the [Next] button in the advisory dialog box
The [Add New Connection Wizard (Searching for Bluetooth devices)] window will 
appear. 

Once the program has finished searching for the devices, the [Add New 
Connection Wizard (Device Selection)] window will appear.

4. Select the name of the device designated as the server from [Device List], and then 
click on the [Next] button
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The [Add New Connection Wizard (Searching for Services)] window will appear.

 

The [Add New Connection Wizard (Confirm Connection Name)] window will appear. 

5. Click on the [Next] button
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The registered icon will appear in the [Bluetooth Settings] window.

■Connecting to a server

1. Right-click on the icon in the [Bluetooth Settings] window, and then click on 
[Connect]

Once you have connected, the icon will change to indicate that the device is 
connected.

 

■Ending a connection to a server

1. Right-click on the icon in the [Bluetooth Settings] window, and then click on 
[Disconnect]

Procedure

Procedure
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A message confirming whether you wish to disconnect will appear. Click on the [Yes] 
button.

Once you have disconnected, the icon will change to indicate that the device is not 
connected.

 

 

This section describes how to send a fax using a Bluetooth wireless modem station.

→Setting up the modem station
→Installing a modem 
→Setting fax information
→Sending a fax

Using a modem station for fax transmissions [FAX]
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g
→Receiving a fax

Please refer to the modem station instruction manual for information on how to connect the 
station to a telephone line. 
Please ensure that any drivers used to connect the PC to the modem have been installed.
A Bluetooth passkey (PIN code) is required for you to connect to the modem station. Please 
make a note of your Bluetooth passkey before you start the set -up process.
A fax application is required for you to be able to send and receive faxes. The description 
below is based on a example using Microsoft Fax, which is installed with Windows XP as 
standard. 
If you are going to use a commercially available fax application, then please refer to the 
manual that came with the application for information on how to send and receive faxes. 

Set up and register the modem station as a fax service.

1. Turn on the wireless modem station

2. Right-click on the Bluetooth icon in the task tray, and then click on [Add New 
Connection]

 

Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], 
and then click on [New Connection] from the active [Bluetooth Settings] 
window. 

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] 
window will appear.

3. Select [Custom Mode], and then click on the [Next] button

Important

Setting up the modem station

Procedure

Note
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The [Add New Connection Wizard (Searching for Bluetooth devices)] window will 
appear.

Once the program has finished searching for the devices, the [Add New Connection 
Wizard (Select Device)] window will appear.

4. Select the device name of the wireless modem station from [Device List], and then 
click on the [Next] button
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The [Add New Connection Wizard (Searching for Services)] window will appear.

 

5. If you are connecting to the wireless modem station for the first time, enter the 
passkey for the device from the [Bluetooth Passkey (PIN Code)] window, and then 
click on the [OK] button

Once the program has finished searching for the services, the [Add New Connection 
Wizard (Select Service)] window will appear.

6. Select "Fax" under [Select Service], and then click on the [Next] button
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The [Add New Connection Wizard (Connecting to Remote Device)] screen will 
appear.

The COM port and modem registration process will then be automatically performed.

 

Once the COM port and modem (standard 33600 bps type) registration is complete,
the [Add New Connection Wizard (Setting Connection Name)] screen will appear.

7. Configure the type and name of the icon to appear after registration,
and click on the [Next] button.

Please click only on the [Next] button once you are satisfied with the configuration. 

The [Add New Connection Wizard (Completing the Add New Connection Wizard)] 
screen will appear.
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8. Click on the [Finish] button

The settings will be registered, and the icon will appear on the [Bluetooth Settings] 
screen.

 

Configure send/receive settings and register fax information. 

1. Select [Start]→[Control Panel], and then double-click on the [Printers and Other 
Hardware] icon

If the control panel is displayed in "Classic view", and you use Windows 2000, 
please start from Step (2). 

2. Double-click on the [Printers and Faxes] icon
The [Printers & Faxes] window will appear.

3. Click on "Install a local fax printer" in the [Printers and Faxes] window

A window showing installed programs will appear, and a Fax icon will have been 

Setting FAX information

Procedure

Note
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created in the [Printers and Faxes] screen.

4. Click on "Send a fax" under "Printer Tasks" on the left side of the window

If you have not yet configured a fax device, the [Fax Configuration Wizard] window 
will appear. In the window you can enter settings pertaining to the sender (yourself). 

If the fax configuration information has already been registered, the [Send Fax 
Wizard] window, which can be viewed under "Sending a fax" below, will appear 
instead of the [Fax Configuration Wizard] window. 

5. Enter the sender information, and click on the [Next] button

Note
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The sender information that you configure here will be automatically appended 
as header information when you send a fax. 

The [Fax Configuration Wizard (Select Device for Sending or Receiving Faxes)] 
window will appear.

6. Select a device to be used for fax transmissions, enable the device for sending or 
receiving, and then click on the [Next] button

If [Enable Receive] is selected, the device will be on standby for receiving faxes 
even if it is not sending or receiving anything, and therefore will be in 
continuous connection to the wireless modem (when COM Auto Connect is on).
Please decide whether to select this option based on the desired objective and/or 
frequency of transmission. 

The [Fax Configuration Wizard (Transmitting Subscriber Identification (TSID))] 
window will appear.

7. Click on the [Next] button
It is important that you do not change the transmitter subscriber identification. 

Note

Note
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The [Fax Configuration Wizard (Completing the Fax Configuration Wizard)] window 
will appear. 

8. Click on the [Finish] button

The fax information will be have been registered, and the [Fax Console] window will 
appear.

This will complete the fax set-up process. 

Related topics: "Sending a fax" and "Receiving a fax"

This section describes how to send a fax from the Fax Console. 

Important

Sending a fax
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The Fax service must be enabled for sending in order for you to send a fax.
Please refer to "Using a wireless modem station" under "Troubleshooting" for how to 
change the send and receive settings once the service has been configured. 

1. Double-click on the [Fax] icon in the Control Panel 
The [Fax Console] window will appear.

2. In the [Fax Console] window, click [File]→[Send fax]
The [Send Fax Wizard (Starting the Send Fax Wizard)] window will appear. 

3. Click on the [Next] button

Important

Procedure
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The [Send Fax Wizard (Recipient Information)] window will appear.

4. Enter the name and fax number of the destination party, and then click on the [Next] 
button

The [Send Fax Wizard (Preparing the Cover Page)] window will appear.

5. Specify the cover page template, subject line, and note (body text), and then click on 
the [Next] button

The [Send Fax Wizard (Schedule)] window will appear. 

6. If you wish to send the fax immediately, select "Now", and then click on the [Next] 
button



Introduction 第 74 頁，共 224 頁

file://C:\Documents and Settings\anitachou\Local Settings\Temp\~hh114B.htm 2004/11/30

The [Send Fax Wizard (Completing the Send Fax Wizard)] window will appear.

7. Confirm the destination information and transmission details, and then click on the 
[Finish] button

The software will automatically dial the number and send the fax.

Once the fax has been sent, Fax Monitor will revert to standby mode.
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Related topic: "Receiving a fax" 

This section describes what to do when a fax arrives after you have established a connection 
to a modem station.

The Fax service must be enabled for receiving in order for you to receive a fax.
Please refer to "Using a wireless modem station" under "Troubleshooting" for 
information on how to change the send and receive settings once the fax service has 
been configured. 
Please ensure you have connected to a modem station before you receive a fax (the 
device will be connected to the modem if "Enable Receive" has been selected or COM 
Auto Connect has been activated). 

1. When a fax arrives, the Fax Monitor will start automatically as the fax is received

 

Once the fax has been received, the Fax Monitor will revert to standby mode. 

If you have enabled manual fax reception, the message below will appear when a 
fax arrives.

Important

Procedure

Note

Receiving a fax
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Click on the message with your mouse to receive the fax.

2. Double-click on the [Fax] icon in the Control Panel
The [Fax Console] window will appear.

3. In the [Fax Console] window, double-click on the fax that has arrived

An image of the received fax will be displayed.

Related topic: "Sending a fax"




